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Chapter 1

Chapter 1 : General Information

About DSE 890 installation, connecting to a drive, and launching DSE890.

♦ Introduction

♦ DSE 890 Installation

♦ Connecting to the Drive

♦ Launching DSE 890
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Introduction
DSE 890 (Drive System Explorer) is the software tool for the new 890 range of drives available from SSD
Drives. It can parameterise, configure and program both the 890CD Common Bus Drive and the 890SD
Standalone Drive.
Using straightforward block programming you can very quickly become a confident user of DSE 890.
Users of LINK and DSD (Drive System Designer), our two previous products, will appreciate DSE 890's
similarity with DSD and familiar features.
However, DSE 890 is new. A major concept is that of having three environments: Motor Control,
Application, and the I/O Elements:
Motor Control: this is a fixed environment comprising
drive and motor parameters organised into blocks. You can
parameterise these blocks, or you can read and write to
them by linking their parameters with blocks in the
Application environment.
Application: this is the working space, external of the
Motor Control environment. In it you can place any number
of instances of any block - gone are the days of fixed
numbers of blocks. Beyond that, the DSE 890 world is not
flat - you can create well structured, multi-layered
applications using the Macro feature, which allows you to
create a compound block representing an entire block
diagram.
I/O Elements: this is an illusionary environment where all
the drive's I/O is gathered. However, you do see this I/O
bought out in the relevant blocks in the Application
environment.

DSE890

890 FirmWare

890 configuration/application

Motor
Control

I/O

Application

Motor
Control

I/O Block

I/O Block

Block
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DSE 890 Installation
The 890 Drive is supplied with a CD containing the DSE 890 Configuration Tool. You can install DSE 890
on any PC with the following minimum specification:

♦ Windows XP, Home or Professional Edition

♦ 100Mb of free hard disk space
Insert the CD and execute the "setup.exe" file on the disk to install the latest LINK database and DSE
890. Follow the on-screen instructions.

Installing the USB driver
The DSE installation program "setup.exe" will copy the Texas USB driver files into the appropriate
Windows directories. When connecting the 890 drive for the first time, Windows will acknowledge that it
has found new hardware with the "New Hardware Found" wizard. When prompted for a driver, select the
"Install automatically" option and select "OK".

Note Windows will actually prompt with "New Hardware Found" twice.
This is the expected behaviour of Windows.

The DSE 890 installation program "setup.exe" will also install a copy of the Texas USB drivers into:

C:\Program Files\Texas Instruments\USB-Serial Adapter

If the automatic install method fails, select the "Browse" option and select the directory above once
prompted for a driver by the Found New Hardware Wizard.

Note The wizard will actually prompt for files twice. Point it to this same directory both times.
This is the expected behaviour of Windows.
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If you have already plugged in the 890 Drive and Windows has determined it to be an "Unknown/Other"
device, you must select the device in the Windows Device Manager (under the Unknown/Other Device
Class). Display the properties for the device (by double-clicking it), and then click the "Update Driver"
button on the "Driver" properties tab. This will then bring up a Wizard and you need to point to the
directory of driver files as described previously.

Note The wizard will actually prompt for files twice. Point it to this same directory both times.
This is the expected behaviour of Windows.

Updating the USB driver
To update the USB driver from Windows Explorer, go to MyComputer (Right Click)  Properties 
Hardware  Device Manager  Multi-port serial adapters  TUSB3410 device (Right Click) 
Update. If this does not work, you have to manually uninstall the older version of the USB driver first:

1. Open MyComputer (Right Click)  Properties  Hardware  Device Manager  Multi-port serial
adapters  TUSB3410 device

2. TUSB3410 device (Right Click)  Uninstall.
3. Start  Run  regedit.
4. Go to HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Enum/USB
5. If you have a Vid_0451&Pid_3410 this needs to be deleted

a. Vid_0451&Pid_3410(Right Click)  Permissions  Enable Allow Full Control for you  OK
b. Vid_0451&Pid_3410(Right Click)  Delete.

6. Go to HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Enum/umpport
7. If you have this key, it needs deleting. Follow 5a and 5b to delete this key.
8. Delete umpusbxp.* and umpcomxp.* in windows/inf directory
9. Delete all of the oem*.* files that link to umpusbxp.inf and umpcomxp.inf. You need to do

this manually. Search string ump*.* and search files oem*.*
10. Delete umpusbxp.sys and umpf3410.i51 files in windows/system32/drivers directory.
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Connecting to the Drive
Connect to the 890 Drive using a USB cable: A to mini-B. Connect the PC's USB port to the drive's X10
terminal. For a drive system, you can connect via USB to any drive in the system to gain access to all
drives. All drives in the system are linked via the FireWire Option.
For more information on the FireWire Option please refer to the FireWire Option Technical Manual.

Launching DSE 890
Start DSE 890 by clicking its
program icon in Windows.
Or, in the Windows' Start
Menu click on "All
Programs", you will see
"SSD Drives", and within is
"DSE 890". Click on this to
launch DSE 890.
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Chapter 2

Chapter 2 : First Configuration

How to create, modify and install a new configuration, as well as going online.

♦ Creating a Configuration

♦ Modifying a Configuration

♦ Installing a Configuration

♦ Import/Export a Configuration

♦ The Online Configuration
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Creating a Configuration
1. From the "File" menu, select "New". A Dialog will

pop up. Select a configuration, e.g. 890
Volts/Hertz, and click "OK"

2. When prompted, enter a new configuration
name, e.g. "L890_1", and click "OK".
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3. Here is your first configuration L890_1*.

4. Save the configuration by clicking on File/Save or the Save icon, or select "Save" from the "File" menu.
A standard Windows Save dialog will pop up. You can save the configuration in any directory in your
file system. Once saved, the asterisk "*" against the name will disappear.
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Modifying a Configuration
A configuration can be modified by editing blocks and links, and by inserting or deleting blocks.

Editing Blocks
You can view the contents of any function block in the
configuration by double-clicking the icon for the block.
For example, double click on "AN IN 3" will open the
analog input function block 3.
Where a parameter can be edited, click on the relevant
sub-menu  to display the options (for enumerated and
boolean parameters), or edit the displayed numeric
value directly on the screen by clicking on the value.
When you have finished editing the block select "OK"
to exit the block, otherwise select "Cancel" to exit the
block and disregard any changes you may have made.
When you make any changes, save the configuration by
clicking on the Save icon , or "File Save". This will
remove the asterisk ( * ) against the configuration name.

Editing Links
A link transfers the value of an
output parameter to an input
parameter of another (or the
same) block.
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Links are made by connecting an output to an input, in that order.

To make a link

Hover the cursor over the output line until the cursor changes to an "x". At this
point, click and hold the mouse button. Now stretch the red link to the input
line. When the link turns green, you have a possible connection. To make the
connection, let go of the mouse button.

To delete a link Click on the line. It will turn purple. Press the Delete key on your keyboard.

To reshape a link line Click on the line and hold the mouse button. The line will turn purple. Now you
can drag any part of the line in any direction.

Inserting New Function Blocks
You can insert any number of new function blocks into the Application. For example:
Click on the Block menu at the top of the screen.
1. Move the cursor down to select "Logic" and select "Counter".
2. Click to attach the block icon to the cursor. Move the icon to where you want on the screen. Click again

to release the icon.
3. To insert another of these blocks you can repeat the process or just Copy and Paste the original using the

Edit menu at the top of the page. (The standard Ctrl+C, Ctrl+V and Ctrl+X also apply).

Note For further details of all function blocks, refer to the 890 Engineering Reference manual, Appendix D.
Motor Control Block details are available in DSE 890 by right-clicking a function block in the Motor
Control Block pane and selecting "Help".

Deleting Function Blocks
Select a block and press the "Delete" key. This will delete the block.



 First Configuration

Page 2-6 DSELite 890 Configuration Tool

8

9

10

11

A

B

C

D

1

2

3

4

5

6

7

E

Editing the Motor Control Block
Double-click the Motor Control Block. A new window will display the motor control block diagram.
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Connecting Parameters to the Application
If a motor control block has to be written to or read from the application, Inputs and Outputs respectively
can be added to the Motor Control block diagram for this purpose.

For example, to add a new input parameter called "REVERSE",
open the Motor Control Block diagram, add a new input from the
Block menu, then rename it to "REVERSE" (shown connected to
REFERENCE /REMOTE REVERSE).

On exiting, the motor Control Macro the additional input parameter
"SETPOINT" will automatically appear on the Motor Control block as
shown on the right.
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Installing a Configuration in a Drive
Once you have created your own configuration, you are in a position to install it in the drive. Select
"Command Install At Selected" to install the currently opened configuration into a drive.
The installation is confirmed by the
Scratch Pad message.
The configuration is now installed into
your drive.

Autotune
The configuration must be closed:

1. Trigger Autotune in the drive (via the MMI) and wait for it to be completed.
2. Select File Update; this will update the parameters in DSE's copy of the configuration.

This will ensure that your DSE 890 configuration reflects exactly the state of the drive.

The Online Configuration
Opening the Default Configuration Online

If you did not install a configuration in the drive, select " File Open Online " or simply press "F9" to open
the default, shipping configuration in online mode.

Opening a New Configuration Online
At this point, your configuration should be installed in the drive. Now, select "Command Go Online" and
the configuration will be opened in online mode. Alternatively, you can select "File Open Online", or
simply hit "F9".
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Working Online
The ONLINE configuration window looks the same as an OFFLINE
version, but has some extra features. Note that you cannot remove or
add blocks and links in online mode.
When you hover the cursor over the output of a block, the cursor will
change to the shape of a "cross". Shift-click puts the parameter into
the Monitor List. To read the value in the function block and the
scratchpad, just click on the parameter. DSE 890 will get and display the actual value from the drive.

The Scratch pad will become visible and will display the retrieved value. The same happens if you click on
an input of a block while holding the "SHIFT" key.

If you want to change an input value of a function
block, simply click on the block input while holding
down the "CTRL" key. This will bring up a dialog
prompting for the value to be set. For instance, clicking
on AN IN 3 : SCALE while holding the CTRL key will
open the following dialog.
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Chapter 3

Chapter 3 : DSE 890 Tools

An explanation of the DSE 890 tools for working on configurations.

Introduction
The Properties View
The Scratch Pad
The Parameters View
The Configuration View

The ONLINE Configuration

• Scratch Pad

• The Monitor List

• The Chart Recorder

• The Oscilloscope
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Introduction
It is assumed that at this point you have launched DSE 890. The DSE 890 main window uses the standard
Windows menu bars, scroll bars, title bars etc. If you are unsure about these, consult your Windows
manual.

Main Views
DSE 890 comprises several graphical areas:

Properties View displays global DSE 890 properties
Scratch Pad displays a record of work performed by DSE 890
Parameters View displays a list of all parameters in the active configuration
Configuration View displays the configuration(s)
Monitor List use this to monitor parameters of a selected drive
Chart Recorder use this to monitor parameters of a selected drive
Oscilloscope use this to monitor parameters of a selected drive

All these views can be accessed through the DSE 890's "View" menu.

Working with Panes
Monitor List, Chart Recorder and Oscilloscope open as separate windows. All other Main Views are
dockable panes. Either they can be windows (floating panes), or they can be docked to an existing window
where they become a tab (docking pane). You can size and dock all areas and toolbars to wherever you
want in the DSE 890 window. To undock, click on a Pane Title and drag the pane to a desired place. At
first, the area will become a floating pane, but Windows will propose areas to dock the pane to. Releasing
the mouse then will dock the pane to an existing Window as a Tab.
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The Properties View
The Properties view allows you to configure the behaviour of DSE 890 through parameters organized into a
tree. Initially, the Properties View will display all items in the Version section.

Version
AppVersion
The application version is displayed and can not be changed.

Form Version
This displays the version of the pane layout and can be used to
reset the layout to the default settings. To reset the pane layout
to its shipping version, select "Form Version" and set its value
to 0. Then exit DSE 890. After launching DSE 890, the pane
layout is reset to its default.

Language
Select your language from the "Language" item.

Document Settings
These settings refer to a configuration's block diagram and how
it is displayed: Snap to Grid, Grid Size, Block (colors for
selected, advanced and high performance blocks), Connections
(colors for connected, unconnected and selected connections).
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Global Settings
The list of Global Settings are mostly self-explanatory, but a few are explained in more detail below.

Serial Comms Port
This will select the port your drive is connected to. If you have
selected the Comms port correctly, the Serial Comms Port
description field in the Properties View will read "USB-Serial Port".

Drive Parameter View Level
Set this to view Drive Parameters of a certain level. Each parameter
has a viewing level attributed to it, from "Operator" (basic operating
parameters) to "Engineering" (high-end parameters primarily used
by SSD engineers).

Frame Mode
This will set how a configuration's block diagram is displayed: maximized or in a "frame per configuration"
block diagram.

Configuration Mode
This will add a list of parameters to the Configuration View when set to "Block Diagram and Parameter
Tree". The configuration view displays only the block diagram if this mode is set to "Block Diagram only".

Configuration Description Fields
You can set up to 6 description fields here. Double-click the required field (e.g. Field 1). Enter your new
text. These fields can be referenced in a Form that can be inserted in to a Configuration : Insert Form.
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The Scratch Pad
The Scratch Pad reports the activities of DSE 890 to the user. When DSE 890 is started it will display the
DSE 890 version, the date, the user name and company DSE 890 is licensed to, together with the database
ID. You can enter today's date and time into the Scratch Pad: "Edit Paste Time".
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The Parameters View
The Parameter View (View Parameters) displays a tree-view of all blocks and parameters (where
applicable).
"All Parameters" contains a tree view of the entire configuration with all

blocks and all parameters in a hierarchical manner, i.e. it contains the top
level block diagram with all its blocks (a block can itself contain another
block diagram).

"Quick Setup" contains a tree view of a subset of motor parameters, for
example the CONTROL MODE.

In this view you can edit parameter values. For example:
1. Click the "+" next to "All Parameters" (or double-click the name). This

will display all the function blocks in the top level block diagram.
2. Click the "+" next to "ANIN3" (or double-click the name). This will

display all the parameters of the analog input block 3.
3. Double click into the value field of "Sample rate (ms)".
4. Change the value to the desired value.
5. Press enter. The value is now changed.
Another example:
1. Click the "+" next to "All Parameters" (or double-click the name). This will display all the function

blocks in the top level block diagram.
2. Click the "+" next to "Motor Control" (or double-click the name). This will display all blocks for the

Motor Control sub-system.
3. Click the "+" next to "Motor Data" (or double-click the name). This will all parameters for the Motor

Data block.
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4. Click the POWER to allow editing. You will see the
parameter reference number displayed, the full
parameter path as accessed in the block diagram
hierarchy, and if applicable, the maximum/minimum
values and units.

5. Click into the value field to change the parameter value.

The Parameters View provides a convenient means to
change parameter values throughout the configuration.

Note that all firmware parameters can be referenced by a
parameter reference (Pref) number in the format:

BLOCKNUMBER.PARAMETERNUMBER
You can read the parameter reference in the Parameters
View. For instance, the Parameter Reference for "MOTOR
DATA/POWER " would be "27.2".
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The Configuration View
The default configuration for the 890 is shown below. It contains the Motor Control block, the function
blocks required by the default Application and their links.
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Modifying the Configuration
A configuration can be modified by changing parameter values of existing blocks, adding new blocks, or
adding/deleting links between function blocks. In addition, graphical elements can be added to improve the
understanding of your configuration.

Function Block Properties
A block icon displays the Instance, Class Name and Parameter Name.
Inputs are shown on the left of the block, outputs are shown on the right.
You can use any number of the same type of block - another Instance of that block will be produced.
Rename the Instance name for the block by right clicking on the block and selecting "Rename".

COUNTER

INPUT
DIRECTION
RESET

CN.1
Name and Instance

Input
U Output

Block type

Parameter
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Editing Blocks
You can view the contents of any function block in the
configuration by double-clicking the icon for the block.
For example, double click on "AN IN 3" will open the
analog input function block 3.
Where a parameter can be edited, click on the relevant
sub-menu  to display the options (for enumerated and
boolean parameters), or edit the displayed numeric
value directly on the screen by clicking on the value.

When you have finished editing the block select "OK"
to exit the block, otherwise select "Cancel" to exit the
block and disregard any changes you may have made.
When you make any changes, save the configuration by clicking on the Save icon , or "File Save". This
will remove the asterisk ( * ) against the configuration name.

Editing Links
A link transfers the value of an output parameter to an input parameter of another (or the same) block.

Links are made by connecting an output to an input, in that order.
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To make a link

Hover the cursor over the output line until the cursor changes to an "x". At this
point, click and hold the mouse button. Now stretch the red link to the input line.
When the link turns green, you have a possible connection. To make the
connection, let go of the mouse button.

To delete a link Click on the line. It will turn purple. Press the Delete key on your keyboard.

To reshape a link line
Click on the line and hold the mouse button. The line will turn purple. Now you
can drag any part of the line in any direction. Click away from the line to
deselect it. The line will turn black.

To split a link

This allows you to split a link on a page or between different pages of the
configuration.
To split a link on a page:

Make the link (as above). Double click on the link to select it. It will turn
purple and a message box will appear. Confirm to split the connection.
The link will be split with the relevant text pointers.

To split a link between different pages:
Make the link (as above) but, while holding the mouse button, click on
"►" . This will open the next page and allow you to
connect to an input on that page. The link will be made with the relevant
text pointers.
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Inserting New Function Blocks
You can insert any number of new function blocks into the Application. For example:
Click on the Block menu at the top of the screen.
4. Move the cursor down to select "Logic" and select "Counter".
5. Click to attach the block icon to the cursor. Move the icon to where you want on the screen. Click again

to release the icon.
6. To insert another of these blocks you can repeat the process, or just Copy and Paste the original using

the Edit menu at the top of the page. (Ctrl+C to copy, Ctrl+V to paste, and Ctrl+X  to cut selected text
also apply).

Note For further details of all function blocks, refer to the 890 Engineering Reference manual, Appendix D.
Motor Control Block details are available in DSE 890 by right-clicking a function block in the Motor
Control Block pane and selecting "Help".

Deleting Function Blocks
To delete a block, select the block and press the "Delete" key.
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Macro Blocks
An important feature of DSE 890 is the use of the Macro Block. These blocks can be used to run a portion
of the application. Because the blocks can be layered, the entire application can be organised in a
hierarchical and structured manner. (The Motor Control block is in fact a Macro block).
To insert a Macro block, go to the Block menu and select "Macro".

As a result, a new Macro block will be added to your configuration. Double click on the block to open the
new, empty diagram. You can add blocks (including further Macro blocks) and links as usual. In addition,
you may add input and/or output blocks from the "Blocks" menu using "Input" and "Output" respectively.
Adding one input and one output and connecting them together would create the following diagram. Note
that the input and output will automatically appear as additional ticks on the Macro block icon.
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Network I/O Blocks
When in the main, or top level diagram, selecting "Input" or "Output from the "Blocks" menu will create a
Network input or output respectively. You must provide the node ID of the source as well as a slot number,
which acts as unique identifier.

The Description field will become the input/output block name (Instance).

Connecting Parameters to the Application
Refer to "Connecting Parameters to the Application" on page 7.
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Inserting and Creating Forms
DSE allows you to add forms to a configuration. Either you can add an existing form through the menu
"Insert -> Forms -> Name of the form to be inserted", or you can create a new form.
If you want to create a new Form, select menu "Insert -> Forms -> Create …" which will display the dialog:

After entering a name, e.g. "Form 1" and selecting OK, an empty Form will be created.

Using the Drawing Toolbar you can add any drawing element.
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The ONLINE Configuration
Note You cannot remove or add blocks and links in ONLINE mode.

To go ONLINE, refer to page 2-8.
The ONLINE configuration window has "ONLINE" displayed in the title, but otherwise the window looks
the same as the OFFLINE version, but it does have some extra features.
Move your cursor over the "tick" of the parameter in the function box and the cursor will change to an "X".
Now you can:

• Click the input or output of a block to display the
actual value from the drive in the Scratchpad.

• SHIFT-click the output of a block to add that
parameter to the Monitor List.

• CTRL-click the input of a block to change the parameter value.
This will bring up a dialog prompting for the value to be set.

• Right-click a parameter to display a menu of actions applying to the
parameter (right-clicking a parameter in the Parameters View has the same effect):

Get Display the parameter value in the Scratchpad.
Monitor Add this parameter to the Monitor List
Chart Add this parameter to the Chart Recorder
Scope Add this parameter to the Oscilloscope.

Note that in all cases the Scratchpad will display the latest value.
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The Monitor List
The Monitor List displays all the drive parameters that you are
monitoring and continuously gets updated values from the
drive.

The Monitor List Toolbar
The toolbar contains several buttons:

Open saved Monitor List configuration from a file.
Save Monitor List configuration to a file.
Toggle the Monitor List to be on top.
Start recording to a file.
Stop recording.
Change the font of the items in the monitor list.
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Adding Parameters to the Monitor List
You can add a parameter to the Monitor List either from an ONLINE Configuration or from the ONLINE
Parameter View, e.g. adding the analog input 3 "AN IN 3" results in the following Monitor List. Parameters
from several drive nodes (or modules) in a drive system can be monitored in the same list.

You can easily remove a parameter from the Monitor List by a right click and selecting "Delete".

"Set", available for this parameter, brings up a dialog to change the value. Enable and Disable allow this
parameter to enabled or disabled from being updated in the Monitor List.

Monitor List Information
"Parameter" displays the configuration name/instance/parameter name
"Value" displays the current value, constantly updated.
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The Chart Recorder
The Chart Recorder displays the values of the selected parameter(s) and continuously gets updated values
from the drive.
Here is a typical chart. It shows one parameter, analog input 3 "AN IN 3".
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The Chart Recorder Toolbar
The toolbar contains several buttons:

Open saved oscilloscope data or configuration from a file.
Save captured oscilloscope data and configuration to a file.
Print oscilloscope plot.
Toggle the Chart Recorder to be on top.
Display/Hide the property grid.
Restart data acquisition.
Pause data acquisition.
Start recording to a file.
Stop recording.

Adding Parameters to the Chart Recorder
You can add a parameter to the chart recorder either from the ONLINE Configuration or from the ONLINE
Parameter View.
Parameters from several drive nodes (or modules) in a drive system can be charted on the same chart.

Setting-up the Chart Recorder
The Chart Recorder displays menus for Settings and Channels.
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Settings
"Settings" displays the settings for how the chart recorder displays the
information.

Time base [s] : This is the time period shown by the chart (x axis)
Chart Mode : When False the chart redraws at the end of the time range; when True the

chart scrolls continuously
Y axis automatic : When False the Y axis is set by "Y axis min" and "Y axis max"; when True

the Y axis is set automatically
Y axis min : Sets the minimum Y axis for the chart
Y axis max : Sets the maximum Y axis for the chart
Background color : Background color of the chart
Grid color : Foreground color of the chart
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Channels
"Channels" lists the current parameters being charted. Every parameter is
listed by parameter name. You can also set a display color for each
parameter.

Offset : The Y axis offset
Gain : The Y axis gain (amplitude, multiplier)
Active : False suspends the charting for this line, True activates the charting
Pen width : Sets the line thickness of the charted line (note that the order of parameters

in the list determines the drawn order on the screen - the last parameter to
be added is uppermost)

You can delete a parameter from the chart by right-clicking on its name
and selecting Delete.
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The Oscilloscope
The Oscilloscope will set-up a real-time data acquisition facility inside the drive firmware, wait for data to
be ready, retrieve the data and display it. This is a tool to capture and display fast signals from external or
internal triggers.
Shown opposite is a
typical chart,
"FEEDBACKS/SPEED
FBK %" with
parameter reference
"70.6".

All parameter values
are normalised into 10
divisions in the main
display area. Time is be
displayed in
milliseconds.
"Measurement", at the
bottom of the screen,
displays measured
values such as
minimum, maximum
and RMS. In addition
this is the display area
for the cursors.
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The Oscilloscope Toolbar
The toolbar contains several buttons:

Open saved oscilloscope data or configuration from a file.
Save captured oscilloscope data and configuration to a file.
Print oscilloscope plot.
Copy oscilloscope plot to clipboard
Toggle the Oscilloscope to be on top.
Display/Hide the property grid.
Download the oscilloscope set-up to the drive.
Manually hold the data if no trigger has occurred.
Stop polling for the status.
Upload the data once available for upload.

Adding Parameters to the Oscilloscope
You can add a parameter to the Oscilloscope either from an ONLINE configuration or from the ONLINE
Parameter View, e.g. adding the speed feedback in rpm from MOTOR CONTROL / FEEDBACKS /
SPEED FBK RPM result in the following oscilloscope view.
Note that only firmware parameters can be scoped.
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Another way to add parameters to the oscilloscope is to right-click on "Nodes", which will bring up a menu
with three choices:

Add Address Add a physical address in the firmware to scope
Add Special Add a special parameter from a pick list
Add Pref Add a parameter reference number

In all three cases you will be prompted to enter the module
node number with a dialog.

• In the case of Add Address, you will be prompted to enter
a memory address as a hexadecimal number, e.g. 0x0010.

• In the case of Add Special, a pick list will appear, show
opposite. This pick list will depend on the type of
configuration, e.g. Permanent Magnet Motor
configuration will be different from a Volts/Hertz one.

• In the case of Add Pref, a dialog will prompt for a
parameter reference number, which expects the format:

BLOCKNUMBER.PARAMETERNUMBER
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Setting-up the Oscilloscope
The Oscilloscope displays menus for Settings, Cursors and Nodes. The oscilloscope facility will do nothing
until it is set-up.

Settings
"Settings" displays the settings for how the oscilloscope displays the
information.

Description : Description printed in the legend
Show Legend : Show legend in plot
Time Scale : Time scale on plot x axis
Cyclic Mode : Carry out data acquisition in a cyclic manner
Background color : Background color of the scope
Grid color : Grid color of the scope

Cursors
"Cursors" controls the cursors for X and Y axis.

Active : Select None, Horizontal, Vertical or both cursors
Channel : Select the channel the cursor should apply to
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Axes
"Axes" are named axis for the plot that can be added by the user.
Each plotted channel comes with its own axis. In order to group several
channels into one axis, a named axis can be added and its minimum and
maximum values can be specified.

Maximum : Sets maximum value in the data display area
Minimum : Sets minimum value in the data display area

Nodes
"Nodes" lists in hierarchical order the parameters to scope for each node.
Once a parameter has been added to the scope, a node will be added
automatically. The node name will be the name of the corresponding
configuration.
Each node entry will then contain a "Setup" item and a "Channels" item.
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Setup
"Setup" contains all the information to set up the data
acquisition facility in the drive.

Trace* Mode Hold Trace on Trigger, Start, Stop or Full
Trigger Direction Falling, Rising or no trigger
Trigger Source Pull down list of available parameters
Trigger Value Numerical value of parameter to trigger on
Trigger is Real Value If true the raw data are scaled.
Trigger Location Location in % of the entire data sample where the trigger is expected.
Sample Number Number of samples to be acquired
Sample Rate Sample rate in period defined next
Sample Period Sample period, either milliseconds, or on the fastest task in the firmware, the

pattern generator.

* The term "trace" is used as a synonym for "data acquisition".
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Channels
"Channels" controls channel configuration and contains a
"Channel" entry per parameter using the name of the parameter.
This entry also sets a color for the parameter.

Type : Type can be either  value, i.e. a real data type, or an integer.
Active : False suspends the display and setup for this channel

True activates the display and setup.
Axis : The Axis can be assigned automatically, manually with minimum and

maximum specified, or assigned to a named axis.
Minimum : Sets minimum value in the data display area
Maximum : Sets maximum value in the data display area
Pen width : Sets the line thickness of the charted.
Comment : The comment added here will appear in the printed version
Offset : Sets the offset of the channel
Gain : Sets the gain of the channel

A parameter (channel) can easily be removed by a right click on the
parameter and selecting "Delete".
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Using the Oscilloscope
1. Set the Trace Mode.

2. Set-up the trigger conditions: Trigger Direction, Source, Value, and Type.

3. Set the Trigger Delay (the percentage of total number of samples occurring before the trigger).

4. Set the Sample Number (the total number of samples to be captured)

Trigger location (%)

Total Number of Samples

time

trigger

5.  Download the oscilloscope set-up to the drive. This will begin the data acquisition.

6. When a trigger occurs, data acquisition continues until the total number of samples are acquired.
At this point, the trace facility will go into a HELD status.

7. DSE 890 will upload and display the captured data.
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Chapter 4

Chapter 3 : How-To

A quick list of common requirements and problems.

• How-To
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How-To
Install a Configuration

If you have created your own configuration, you need to install it in the drive.
There are two methods for installing a configuration:
1. Select "Command Install At Selected" to install the currently opened configuration into a drive

selected in the Module List (a list of all drives that are connected to the PC).
2. Select "Command Install At Address" to install the currently opened configuration at the Net

address for the drive (defined in the configuration, see XXX to change the net address.)
The installation will be confirmed by a Scratch Pad message.
Now the configuration is installed into your
drive. You are now the owner of this
configuration. It cannot be edited by
another copy of DSE 890 without your
consent.

Open a Configuration ONLINE
Select File->Go Online.
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Install New Firmware
In the Command Menu, select "Install Firmware". A dialog will pop up which allows you to select a
firmware:

Once selected, press OK and the firmware download will start. It may take a few minutes.
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Chapter 5

Chapter 5 : Toolbars & Menus

A listing of all DSE 890 toolbars and menus.

♦ Toolbars

♦ File Menu

♦ Edit Menu

♦ View Menu

♦ Block Menu

♦ Command Menu

♦ Insert Menu

♦ Format Menu

♦ Window Menu

♦ Help
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Toolbars
Note DSE 890 uses the standard Windows toolbar controls for operating, sizing, moving and customising the

toolbars. If you are unsure about these controls, consult your Windows manual.
There are three default toolbars: "Standard", "Drawing" and "Text". You can customise these toolbars and
also create new toolbars. You can also undock them creating a floating toolbar.

The "Standard" Toolbar
Open Opens a new configuration. Select "New" to open one of the supplied configurations, or select

from your list of recently opened configurations.
Save Saves the configuration. An unsaved configuration displays an asterisk in the name.

Full Screen Displays the selected configuration full screen. Other open configurations are displayed as tabs.
To return to normal view, select View\Full Screen.

Magnify Left click to zoom in, right click to zoom out. Click the icon again to disable the feature.
Install at Address Installs the open configuration to the net address selected via Edit/Net Address.
Install at Selected Installs the open configuration to the drive selected in the Module List.
Install Changes Installs changes to the configuration
Restart Node Restarts the application in the drive selected in the Module List
Halt Node Halts the application in the drive selected in the Module List

Identify Node Identifies the drive selected in the Module List by changing the green flashing STATUS LED on
the drive to orange (for approximately 10 flashes).

Get Info. Displays a set of information in the Scratch Pad about the drive selected in the Module list.
Module List Refreshes and displays the Module List.
Monitor List Displays the Monitor List
Chart Recorder Displays the Chart Recorder
Oscilloscope Displays the Oscilloscope
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Drawing Information
DSE 890 allows to add drawing information to a configuration.
This can be done by two tool bars, the Drawing and the Text tool
bar.
The operation of these toolbars is very intuitive and similar to
many widely used programs. For this reason, the details of the
"Drawing" and "Text" toolbars are not explained.
The "Drawing" and "Text" toolbars can be used to annotate the
Configuration Window and the Motor Control pane. For example,
the blue diagrams in the default "New Configurations" are
produced in this way.

The "Drawing" Toolbar
ARROW, LINE, OVAL, RECTANGLE, IMAGE, LINE COLOR,
FILL COLOR, FRONT, BACK, GROUP, UNGROUP, PATTERN,
LINE WIDTH, LINE PATTERN.

The "Text" Toolbar
TEXT, FONT, SIZE, FONT COLOR,  BOLD, ITALIC,
UNDERLINE, LEFT, CENTERED.



Toolbars & Menus

Page 5-4 DSELite 890 Configuration Tool

8

9

10

11

A

B

C

D

1

2

3

4

5

6

7

E

Menus
File
New… Ctrl+N Creates a new default configuration
Open ► Opens a configuration
Open History… Opens revision history of current configuration
Open Selected F2 Opens configuration of selected module in Module List
Open Online F9 Opens configuration of selected module in Module List in ONLINE mode
Extract Selected Extracts selected items and save to a file
Close Closes the active window
Close All Closes all configurations
Discard Removes the configuration without saving
Save Ctrl+S Saves the configuration
Save As… Saves the configuration using a new configuration name
Save All Saves all configurations
Import Imports configuration elements from a file
Update Selected Updates configuration with parameter values from selected module
Print Setup… Setup your printing requirements
Print Preview Shows how the page will print
Print… Ctrl+P Prints the active window
Exit Closes this program
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Edit
Undo Ctrl+Z Reverses your last action
Cut Ctrl+X Cuts the selected item from the window (to the clipboard)
Copy Ctrl+C Copies the selected item to the clipboard
Paste Ctrl+V Inserts the contents of the clipboard to the active window
Delete Deletes the selected item
Import Import selection
Export Export selection
Select All Selects all items in the active window
Duplicate Ctrl+D Duplicates the selected item(s)
Paste Time Pastes today's date and time in the Scratch Pad
Insert Sheet Insert a sheet into the configuration
Delete Sheet Delete a sheet from the configuration
Delete Form ► Delete a Form from list

Edit Form ► Edit a Form from list

Find Input… F10 Find block input by name
Find Output… F11 Find block output by name
Net Address (1)… Sets the net address for the drive module in a drive system
Performance ►

Standard Displays standard blocks in the Block Menu (black)
Advanced Displays advanced blocks in the Block Menu (green)
High Displays high blocks in the Block Menu (green)

Motor Wizard Launches the Motor selection wizard
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View
Full Screen F12 Toggles full screen view by hiding toolbars etc.
Magnify Magnifies the configuration
Show Grid F7 Shows a drawing grid
Oscilloscope Toggles the Oscilloscope view
Chart Recorder Toggles the Chart Recorder view
Monitor List Toggles the Monitor List view
Parameters Selects the Parameter View
Properties Displays the Properties menu for DSE 890
Scratchpad Toggles the Scratch Pad
Toolbars ► Display the toolbars

Standard Toggles the Standard toolbar
Drawing Toggles the Drawing toolbar
Text Toggles the Text toolbar
Ladder Brings up the Ladder Editor Toolbar

Status Bar Toggles the Status Bar
Forms Toggles Forms
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Block
Input Network input on top level diagram, else macro input
Output Network output on top level diagram, else macro output
Macro Block representing a block sub-diagram
890 ► 890 blocks
: : :
Winders ► Winder blocks

Note The "Block" menu is only visible when a Configuration pane is on the screen.
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Command
Install at Address Ctrl+T Installs the open configuration to the net address selected via Edit/Net Address.
Install at Selected Ctrl+G Installs the open configuration to the drive selected in the Module List.
Install Changes F3 Installs changes to the configuration
Full Install at Selected Installs full configuration in selected drive
Go Online Go ONLINE with the currently opened configuration
Restart Restarts the application in the drive selected in the Module List ?
Halt Halts the application in the drive selected in the Module List
Identify Identifies the drive selected in the Module List by changing the green flashing

STATUS LED on the drive to orange (for approximately 10 flashes).
Get Info. Displays a set of information in the Scratch Pad about the drive selected in the

Module list
Refresh Refreshes and displays the Module List.
Upgrade Firmware Upgrade drive firmware
Set Serial Number Set serial number in drive firmware
Set Performance Level Set performance level for drive
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Insert
Text F4 Inserts a text box
Arrow F5 Inserts a line with arrow
Line F6 Inserts a line
Oval Inserts an oval
Rectangle F8 Inserts a rectangle
Image Inserts a selected bitmap image file
Form Create… ► Create a new Form in a new view

Form X List of Forms to be inserted
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Format
Align Ctrl+A Align drawing elements
Text Font… Changes the font attributes of selected text
Text Face Select the typeface for selected text
Text Size Select the type size for selected text
Text Color Select the color for selected text
Bold Toggles the Bold attribute for selected text
Italic Toggles the Italic attribute for selected text
Underline Toggles the Underline attribute for selected text

Left Justified Aligns selected text to the left, ragged right
Center Text Centers selected text
Line Color Select the line color
Fill Color Select the fill color
Move to Front Move selected object in front of other objects
Move to Back Move selected object behind other objects
Group Group selected objects together
Ungroup Ungroup selected compound
Pattern Select a pattern fill
Line Width Select a line width
Line Pattern Select a line pattern
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Window
Cascade Arranges windows as separate tabs
Tile Arranges split-screen windows
Arrange Icons Arrange icons at the bottom of the window

Help
Contents… Opens the DSE 890 manual to search the Contents
Index… Opens the DSE 890 manual to search the Index
Search… Opens the DSE 890 manual to search for specific words
About DSE 890… Displays the version number and other information about DSE 890
General -
Data Sheets Opens data sheets about DSE 890



Toolbars & Menus

Page 5-12 DSELite 890 Configuration Tool

8

9

10

11

A

B

C

D

1

2

3

4

5

6

7

E



DSE 890 Configuration Tool


	Front Cover
	HA471486U001_01.pdf
	Chapter 1 : General Information
	Introduction
	DSE 890 Installation
	Installing the USB driver
	Updating the USB driver

	Connecting to the Drive
	Launching DSE 890

	Chapter 2 : First Configuration
	Creating a Configuration
	Modifying a Configuration
	Editing Blocks
	Editing Links
	Inserting New Function Blocks
	Deleting Function Blocks
	Editing the Motor Control Block
	Connecting Parameters to the Application

	Installing a Configuration in a Drive
	Autotune

	The Online Configuration
	Opening the Default Configuration Online
	Opening a New Configuration Online
	Working Online


	Chapter 3 : DSE 890 Tools
	Introduction
	The Properties View
	The Scratch Pad
	The Parameters View
	The Configuration View
	Modifying the Configuration
	Function Block Properties
	Editing Blocks
	Editing Links
	Inserting New Function Blocks
	Deleting Function Blocks
	Macro Blocks
	Network I/O Blocks
	Connecting Parameters to the Application
	Inserting and Creating Forms


	The ONLINE Configuration
	The Monitor List
	The Monitor List Toolbar
	Adding Parameters to the Monitor List

	The Chart Recorder
	The Chart Recorder Toolbar
	Adding Parameters to the Chart Recorder
	Setting-up the Chart Recorder

	The Oscilloscope
	The Oscilloscope Toolbar
	Adding Parameters to the Oscilloscope
	Setting-up the Oscilloscope
	Using the Oscilloscope



	Chapter 3 : How-To
	How-To
	Install a Configuration
	Open a Configuration ONLINE
	Install New Firmware


	Chapter 5 : Toolbars & Menus
	Toolbars
	The "Standard" Toolbar
	Drawing Information
	The "Drawing" Toolbar
	The "Text" Toolbar

	Menus



